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1. Getting Started

1.1 Welcome to GMG SpotColor Editor

Note This documentation refers exclusively to GMG SpotColor Editor integrated in GMG ColorProof /
GMG FlexoProof / GMG DotProof.

GMG SpotColor Editor is a profile editor which allows you to edit or create spot color sets and spot color
profiles for the color management of spot colors in GMG ColorProof.

A spot color set contains all information required for the color management of spot colors for a certain set
of printer and media types. Each spot color set in GMG ColorProof is linked to a spot color database
(*.db3). GMG ColorProof provides you with spot color databases for widely used spot colors, for example,
from Pantone, DIC, or HKS.

Example: The spot color set PANTONE® GOE coated - Ex880 GMGsemimatte250 includes all spot colors
of the PANTONE® GOE coated set for Epson Stylus Pro x880 printers and GMG ProofPaper semimatte
250.

Each spot color set can be duplicated, edited and enhanced with further spot colors. If you want to
simulate not only full tones, but also spot color tints, you can either create a spot color profile with several
fulcrums or create a spot color gradation (see "Simulating Spot Color Tints" on page 11) and assign the
gradation to one or multiple spot colors.

Possible applications

create custom spot color libraries

extend your proofing color space with special ink spot colors

more flexibility with paper tint neutral spot colors

calibrated spot color sets for a higher stability of the print output

Setting up a new spot color—Overview

To simulate a spot color on a proof system, you need to define target values. In GMG SpotColor Editor you
can either directly enter Lab target values or measure them from a reference print. The target values are
computed with the color space of the printer-medium-combination (*.csc gamut file) to create CMYK
output values for the proof system.

If you need to proof spot colors within tight tolerances, it is recommended to optimize the spot color
profile by printing and measuring a specific test chart. The measured values are saved as current values
and are compared to the target values. If the delta E deviation is too high, the profile is recalculated. The
profile can be optimized until the delta E between target values and current values meets your
requirements.

Tip Automatic spot color optimization: in combination with GMG ProofControl Inline, spot colors can be
quickly and automatically optimized in GMG ColorProof when using a proofer with an integrated
measuring device. The optimization wizard guides through the process with step-by-step instructions. For
more information, please see the separate documentation on GMG ColorProof.

1.2 What's New?

This chapter summarizes all major changes that have been applied to the program since the latest release.
It is recommended that experienced GMG SpotColor Editor users read the information provided in this
chapter very carefully, so that they can take full advantage of all new software features. Please follow the
links for more information.
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What's New in GMG SpotColor Editor Included in GMG ColorProof Version 5.2.3?

Advantage New Feature See Also

Extend your proofing
color space

Flexo proofing is characterized by far greater substrate and spot color diversity.
As some printers can print special inks such as White or Metallic Silver, you can
now use GMG SpotColor Editor to mix your own spot colors with these inks
which allows for a wide range of colors, such as gold, copper and bronze. This
paves the path for special effects which have not been possible with
conventional inkjet printers but are commonly used in today's packaging print
process.

"Special Ink Spot Colors"
on page 15

What's New in GMG SpotColor Editor Included in GMG ColorProof Version 5.2?

Advantage New Feature See Also

Transparency on the
results that can be
expected from the target
printer-medium
combination

The feature already known from GMG ProfileEditor Estimate Current Values
from CMYK, has now been added to GMG SpotColor Editor. Out-of-gamut
colors can now be easily detected by comparing Current Values with Target
Values, without the need to measure "real" Current Values.

You can select the display option Automatic Update of Estimated Current
Values to automatically refresh the Current Values each time CMYK values
(Colors) are changed.

Compatibility with
world-wide standards

Choose the Color Difference Formula you want to use for comparing Current
Values with Target Values: delta E76, delta E94, delta E2000, or CMC(2:1)

More flexible spot color
simulations for the
packaging business

You can now subtract the paper tint from spot color profiles to create paper
tint neutral spot colors.

"Paper Tint Neutral Spot
Colors" on page 10

Enhanced user
friendliness

Revised user interface: A more descriptive terminology is now being used for
the spot color options. The options are logically grouped in the window.
Changes are only cosmetic. The underlying functionality has not been changed.

"Renamed Software
Options" on page 7
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1.3 Renamed Software Options

The following options have been renamed and regrouped for GMG SpotColor Editor included in GMG
ColorProof Version 5.2. Changes are only cosmetic. The underlying functionality has not been changed.

Previous Name New Name

Calibrated Spot Color Set check box selected Calibrated Set (Use Gamut Defined by Calibration) radio button

Calibrated Spot Color Set check box deselected Uncalibrated Set (Use Full Gamut of Printer) radio button

More Parameters group Overprinting Behavior group

With Color Profile check box Convert to Color Profile (Use Gamut of Profile/MX4) check box

IRIS separation mode in drop-down list Max Black Generation separation mode in drop-down list

White Spot Color check box Special Inks separate settings

1.4 File Formats in GMG SpotColor Editor

The following file formats are used in GMG SpotColor Editor.

Spot color database (*.db3)

Each spot color is saved with Lab target values in a spot color database. To reflect different printing
conditions, you can set up several spot color sets in a database, which can be selected for proofing in
GMG ColorProof in the Manual Job Manager or in a workflow.

Spot color gradation (*.sfg)

As spot colors are generally not subject to the MX4/MX5 color conversion, spot color gradation profiles
can be assigned to a spot color in the spot color database or to a job in the general job settings. Since
adding fulcrums to a spot color in GMG SpotColor Editor is not sufficient to simulate the dot gain behavior
in GMG DotProof and GMG FlexoProof, a gradation can be used to define the dot gain behavior of spot
colors . In ContoneProof mode, a spot color gradation is a simple but effective alternative to defining
several fulcrums for each spot color. The latter is more accurate, takes differences in the dot gain for
individual color channels into account, but also requires a press proof and measurement for each spot
color. With a spot color gradation, it is possible to perform a global correction for multiple spot colors
showing a similar behavior.

Gamut /Full Gamut file (*.csc)

Colors that can be accurately represented by a certain printer-medium combination. If colors are out-of-
gamut, they cannot be adequately represented by the target output device. The gamut file describes the
color space the printer can print according to its technical specifications and the selected medium in a
calibrated state. Gamut files can also be viewed in the GMG ProfileEditor GamutViewer to display a 3d
model of the printer gamut, for example, if you want to check whether a certain (spot) color is inside or
outside the gamut.

Full gamut files describe the complete color space of the printer-medium combination before calibration.
The full gamut file is used for calculating uncalibrated spot color simulations, using the maximum color
space of the printer. The gamut (*.csc) and full gamut files (_fullgamut.csc) of all supported printers can be
found in the main program subfolder Calibrations.

1.5 Best Practices ContoneProof / DotProof

The following table shows you the ideal approach when it comes to simulating certain spot color aspects
in ContoneProof or DotProof mode.
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Aim ContoneProof DotProof

I need the best possible
simulation of the color
interplay between process
and spot colors

Use a CMYK profile in combination with a db3
spot color database.

Note: GMG developed a new profiling software
GMG OpenColor which addresses the overprint
problem of spot colors. GMG OpenColor generates
high-quality multicolor profiles with up to 15 ink
channels simulating the printing behavior of
diverse printing technologies, media types, and
screenings.

Use a CMYK profile in combination with a db3 spot
color database.

Note: For Epson Stylus Pro x900 and HP Designjet
Zx200 printers, you can purchase a GMG DotProof
XG (Extended Gamut) license which enables you to
make the most of the expanded color gamut of these
printers and reproduce more spot colors in halftone
proofs.

I want to simulate spot
color tints

Add several fulcrums to the profile, for example, in
10% steps. For each fulcrum, print, measure, and
optimize the profile as described in chapter
"Optimizing the Spot Color" on page 13.

—OR—

Create a spot color profile with only a 100%
fulcrum and link a Gradation Correction to the
spot color profile as described in chapter
"Simulating Spot Color Tints" on page 11.

For spot colors in halftone proofs, only the 100%
fulcrum should be defined. The reason for this is
that every further fulcrum would just be able to
reflect a minimal color part of the simulated dot.
Therefore, we recommend to simulate the dot gain
with a Gradation Correction, as described in
chapter "Simulating Spot Color Tints" on page 11.
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2. Creating Custom Spot Colors

2.1 Creating a New Spot Color Database

This chapter outlines the creation of a new spot color set in GMG SpotColor Editor. For each spot color in
the set, you need to create a spot color profile (see "Creating a New Spot Color" on page 11). The spot
color sets created in GMG SpotColor Editor can then be imported and used in GMG ColorProof.

Note When creating a gamut / full gamut file for a white spot color, test charts should be printed with
Undercoat of 100% Intensity. For further information, please see the GMG ColorProof documentation.

How to add a spot color set

1. On the Tools menu of GMG ColorProof, click SpotColor Editor.
GMG SpotColor Editor is started.

2. On the File menu, click Open Spot Color Database to create a new spot color database (*.db3 file).
(If you want to add a spot color to an already existing spot color database, click Open External
Database. Please note that when modifying a GMG spot color database, these modifications may be
overwritten when updating the software.)

3. On the tree view on the left, right-click on the SpotColor.db3 named Old_DB and Rename the db3
file.

4. Save the (db3) database file under a meaningful name.

5. On the Edit menu, click Add New Spot Color Set.

6. Click the set name (default name: Set_1) and rename the spot color set.
It might be useful to mention the supported print medium in the name.

7. On the Edit menu, click Add New Spot Color.
A new spot color is added (default name: Color_1).

8. Optional: If you want to use the advantages of a printer calibration for this spot color set, select the
spot color set again and select the option Calibrated Set (Use Gamut defined by Calibration). This
option can only be selected for the whole spot color set and not for single spot colors.

2.1.1 Calibrated Spot Colors

Calibrated vs. not calibrated spot colors

Generally, spot colors should not be subject to an MX4/MX5 color transformation, as this color
transformation simulates the limited color space of the target output device. Spot colors are used for
extending this color space and are printed “as is” on the output device. Thus, it does not make sense to
simulate a limitation that does not really exist. As a consequence, spot colors are not converted by the
MX4/MX5 as default. However, you can overrun this default by selecting the option Convert to Color
Profile (Use Gamut of Profile/MX4) in GMG SpotColor Editor. This option cannot be defined for the
complete set, but has to be selected for each spot color separately.

The printer calibration of the proof printer can be considered for the color management to avoid
differences in the output due to normal printer deviations. On the other hand, the printable color space of
the printer will be reduced (that is, the gamut is used instead of the full gamut) to achieve a very stable
output. Thus, using a printer calibration together with a spot color set is a trade-off between the stability of
the print output and the size of the color space.

The iterative process for determining correct target values for each spot color in GMG SpotColor Editor is
recommended for achieving results that match the original colors as closely as possible. The printer
calibration then assures that this result is stable and not subject to deviations in the printer performance or
environmental parameters.
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The option Calibrated Set (Use Gamut defined by Calibration) is defined for the complete spot color set
and cannot be defined for each spot color separately.

How to enable an MX3 printer calibration for spot colors

Note If you change the option Calibrated Set (Use Gamut defined by Calibration) for an already existing
spot color set, you need to replace the gamut / full gamut file linked to the spot color and create new spot
color profiles for each spot color separately, including an iterative optimization of each spot color profile.

1. On the Tools menu in GMG ColorProof, click SpotColor Editor.
The SpotColor Editor opens.

2. On the File menu, click Open External Database to open the desired spot color database (default
path: <GMGColorProof installation path>\SpotColors\).

3. In the treeview pane on the left, select the desired spot color set.

4. A selected spot color set is highlighted with a different background color.

5. Select the option Calibrated Set (Use Gamut Defined by Calibration).

6. Click the Save button on the SpotColor Editor toolbar. The printer calibration file (from the
calibration set linked to each spot color set in the GMG ColorProof database) is now used for all jobs
that use spot colors from this spot color set.

See also:

l "Creating a New Spot Color Database" on page 9

2.1.2 Paper Tint Neutral Spot Colors

Often, spots are highly saturated colors and are used as a solid color (100%). In this case, the paper tint
does not really affect spot colors (provided that the paper tint is rather light in color).

However, if you are using spot colors that are not highly saturated and/or if you are using different shades
of a spot, the paper tint will affect the color in the same way as for process colors. You probably want to
simulate the paper tint effect of the final output paper in the printed proof. If you simulate multiple print
standards, you probably want to create spot color profiles that can be used together with all print
standards.

How is it possible to simulate different paper tints with the same spot color profile?

In GMG SpotColor Editor, you can define the paper tint of your sample and subtract it from the spot color
profile, thus storing the spot color as such, with a "Neutral Paper Tint".

The printed paper tint is always taken from the MX color profile of the Proof Standard. (This behavior is
independent from the Convert to Color Profile (Use Gamut of Profile/MX4) option.) This way, paper tint
neutral spots can be combined with any proof standard in GMG ColorProof, allowing you to simulate
different print standards and paper tints with the same spot color profile.

The following illustration shows the behavior of a normal spot color (dotted line) and the same spot color
after subtraction of the paper tint (solid line).
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Fig. 1 Comparison of a "normal" and a paper tint neutral spot color.

2.2 Creating a New Spot Color

For each spot color in a spot color set, you need to calculate a spot color profile.

Note The option Convert to Color Profile (Use Gamut of Profile/MX4) color converts the spot color and is
a special case option generally not used to create spot color profiles.

Note To create paper tint neutral spot colors with the Subtract Paper Tint option, you do not need to apply
a special gamut, but only the usual printer gamut.

How to create a spot color profile in GMG SpotColor Editor

1. Enter the characterization data (provided by the spot color manufacturer or measured from a print
sample) as Target Values for all required fulcrums. A single fulcrum at 100 is sufficient for most use
cases.

2. Delete all unused fulcrums (Edit menu > Delete Fulcrum).

3. It is recommended to set up a Calibrated spot color set. Link the gamut file to each spot color in the
set. 

4. Select the required Separation mode, depending on the printer driver and printer type. (Inkjet for
standard CMYK printers).

5. To create a paper tint neutral spot color, which can be used with multiple proof standards, you can
either measure the paper tint at 0%, or manually enter the paper tint values into the spot color profile
(Edit menu > Define Paper Tint).

6. Calculate the CMYK output values in the Colors column (Measure menu > Calculate with Target
Values).

7. If you defined paper tint values, activate the option Subtract Paper Tint to filter out the 'real' spot
color without paper tint.
(In GMG ColorProof, paper tint neutral spot colors are printed with the paper tint values from the
selected MX profile.)

8. Optional: Optimize the profile in an iterative process.

9. Save the (db3) database file.

2.3 Simulating Spot Color Tints

For most spot color applications, it is only required to print the spot color as full-tone (100%) color. If you,
however, want to print spot color tints, there are two possibilities to reflect the dot gain of the spot color:
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Fulcrums in the profile (only recommended for ContoneProof): Add several fulcrums to the profile, for
example, in 10% steps. For each fulcrum you need to print, measure, and optimize the profile by
comparing the proof to a print sample of the corresponding tone value, as described in "Optimizing
the Spot Color" on page 13. Defining the dot gain via fulcrums, which need to be measured and
optimized, is a very accurate, but on the other hand also time-consuming method.

Gradation Correction linked to the profile: Create a spot color profile with only a 100% fulcrum and
link a gradation correction to the spot color profile. This method has the advantage that you only
need one print sample per spot color and only need to optimize the profile once. If several spot
colors show a similar dot gain behavior, you can conveniently assign the same gradation correction
to multiple spot colors.

See also:

l "Best Practices ContoneProof / DotProof" on page 7

2.3.1 Creating A Gradation Correction

Gradation corrections serve different aims in ContoneProof and DotProof mode. If you want to use spots
with a gradation file for both proofing modes, you might experience undesired proof results. We therefore
recommend to create gradation files separately for ContoneProof and for DotProof, as explained in this
chapter.

A gradation correction file can be created in GMG SpotColor Editor (File menu > New Gradation) and is
saved as an sfg file. To simulate the specific dot gain of the printing and the proof system, you can either
manually enter dot gain values or modify the displayed curve by selecting and dragging individual
fulcrums with the mouse. To add or delete fulcrums, use the corresponding commands in the Edit menu.

Tip When saving the gradation correction file, it might be useful to include the proofing mode in the
name, so it is easier for you to keep an overview and to load the correct gradation file in GMG ColorProof.

Gradation corrections for ContoneProof

A gradation correction used in ContoneProof mode affects the CMYK output values of the spot color, thus
defining the color output values at different fulcrums.

Gradation corrections for DotProof

A gradation correction used in DotProof mode directly affects the dot size, but has no impact on the color
as such. To change the color, you need to edit the CMYK output values in the spot color profile, not the
gradation file.

For a best possible dot gain simulation, we recommend not only to take the dot gain of the print system
into account, but also the dot gain of the proof system. Use a densitometer to determine the dot gain of
both systems and calculate a correction curve from both curves. Transfer this curve by entering the
computed values into the gradation file and save the file to a folder GMG ColorProof can access.

Depending on the resolution of the input file and the screen ruling there is an effective range of the dot
gain which is rooted in technical limitations. For example, it is technically not possible to increase a 1%
dot to 40%, especially if you have a small raster cell. The following paragraph gives you some guidelines
on how to modify the dot gain when printing spots in DotProof mode.
(missing or bad snippet)

2.3.2 Applying a Gradation Correction

Gradation correction files can be applied to a spot color in two ways, as described in the following:

Link the sfg file to one or multiple spot colors directly in the db3 spot color database as described in
the following.

Link the sfg file to a spot color set in GMG ColorProof if you prefer flexibility, applying one
gradation correction per GMG SpotColor Editor workflow.

How to link a gradation correction to a spot color in the spot color database



Quick Start Guide for Spot Color Proofing (EN)

13 / 16

1. On the Tools menu in GMG ColorProof, click SpotColor Editor.
The SpotColor Editor opens.

2. On the File menu, click Open External Database to open the desired spot color database (default
path: C:\Program Files\GMG\ColorProof05\SpotColors\).

3. In the Color tree view pane on the left, select the desired spot color. You can also multiselect
multiple spot colors, if you want to link them to the same spot color gradation file.

4. A selected spot color set is highlighted with a different background color.

5. Next to the Gradation box, click the browse button and select the sfg file.

6. Click the Save button on the toolbar.
The gradation file is now used for all jobs using the spot colors of this spot color set.

2.4 Optimizing the Spot Color

You can optimize a spot color profile in an iterative cycle (printing and measuring a test chart,
recalculating the profile). The aim of the optimization is to match the target values as closely as possible.
Following each iteration cycle, GMG SpotColor Editor computes new CMYK output values based on the
deviation between the Lab target values and the measured current values. The new output values are used
in the next printing step. Thus, the current values become closer to the tolerances with each iteration.

To be able to print a test chart with the created spot color in GMG ColorProof, you first need to add a new
spot color set in GMG ColorProof and import the created db3 file (System menu > Spot Color Sets > New).
For more detailed information on adding a new spot color set to the GMG ColorProof database, please see
the documentation of GMG ColorProof.

How to optimize the profile with an external measuring device

Note When optimizing a paper tint neutral spot color, please deactivate the option Subtract Paper Tint
every time you recalculate the values (Calculate with Target and Current Values) and activate the option
again before you save the file.

1. In GMG ColorProof, create a job and print the spot color test chart GMG_SpotColor_<measuring
device>.tif from the Testcharts subfolder with the new spot color (Color Management > Channels >
Choose Spot Color). Select the calibration set and print mode you want to use with the spot color set.

2. In GMG SpotColor Editor, measure the test chart with an external measuring device: On the Measure
menu, click All Current Values. (You can also measure individual patches by pressing the M key.)

3. If Delta E values are too high, recalculate the profile: (Deactivate the option Subtract Paper Tint
before recalculating.) On the Measure menu, click Calculate with Target and Current Values.
The measured values will be compared to the target values. Output values will be adjusted
accordingly. The target values will be computed with the gamut file to produce the output values of
the profile.

4. Repeat steps 1 to 3 until the deviation (delta E) between Target Values and Current Values meets
your requirements.

5. Activate the option Subtract Paper Tint again, if creating a paper tint neutral spot color.

6. Save the (db3) database file.

How to optimize the profile with an integrated measuring device

1. In the Database view > Spot Color Sets tab, right-click a (custom) spot color set and select Optimize
from the context menu.
The Spot Color Optimization wizard is started.

2. Select the printer and print settings you want to use for printing the patches.

3. Click Next.
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4. Select a proof standard or load an MX profile.
The proof standard or profile contains the paper tint values required to simulate the paper type you
plan to use. This is important because different media generate different color results.

5. Click Next.

6. Select the Proof Mode and a test chart template.
You can choose between templates for full tone and gradient spot colors.

7. Select the spot colors you want to print and measure.

8. Click Next.

9. Define the tolerance range for the acceptable deviation of output and target values (delta E).

10. Select an optimization mode (automatic or manual).
Clicking the Next button, GMG ColorProof prints the selected spots, one patch for each fulcrum,
using the paper tint value of the selected MX profile.

11. Run optimization cycles until you are satisfied with the results.
(Click the Details button for more detailed information on the measured values.)
When finishing the optimization, the spot color database is updated with the calculated output
values. The measured values and color names are printed next to the color patches.
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3. Special Ink Spot Colors
Printing an image with special inks such as White, Silver or Silver Blended requires a spot color channel
for each special ink you want to use. You can mix your own spot colors with Metallic Silver or White ink
using special ink settings which can be defined separately for each spot color in a set.

You can define the Area Coverage for the special ink (in our example, we added 50% Silver) by clicking
the Settings button on the bottom of the main dialog. The Area Coverage defines the ink coverage at an
Index of 100%. Between an index of 0% and 100%, the spot color shows a linear behavior. You can,
however, use a gradation correction to tweak the linear behavior.

Fig. 2 Creating a new spot color with Metallic ink in GMG SpotColor Editor.
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4. Reusing Spot Colors on a Different Printer
When changing the printer, the visual appearance of the spot colors may shift, even though you probably
recalculated the spot colors in a colorimetrically correct way. If you want to continue printing your spot
colors exactly as before, with the same visual appearance, you need the original target values used when
calculating the output values of the spot color. As the target values are often not saved or updated after
manual corrections, you need to estimate them as described in the following. After estimating the target
values, you copy the database and calculate the new CMYK output values for each spot color, thus setting
up new spot color databases for your printer which output the spots in the same way as with the old
printer.

How to regain the target values of a spot color

To regain the target values, you need to copy the paper tint value from the MX profile you are using into
the spot color profile, estimate the target values and then subtract the paper tint again (because spots are
printed with the paper tint of the selected color profile).

Note When iterating a paper tint neutral spot color, please deactivate the option Subtract Paper Tint every
time you recalculate the values (Calculate with Target and Current Values) and activate the option again
before you save the file.

Tip If you are using the same print medium for several spot colors, you can multi-select these to define
and subtract the paper tint value.

1. Open a spot color database and select the spot color you want to reuse.

2. Copy the Lab or CMYK paper tint values from the MX color profile of the printer-medium
combination you are using into the spot color profile (Edit menu > Define Paper Tint).

3. Estimate the target values (Measure menu > Estimate Target Values).

4. Activate the option Subtract Paper Tint to filter out the 'real' spot colors without paper tint.

5. Save the database.

6. Right-click the database and select Copy from the context menu.

7. Right-click into the tree view on the right side and select Paste from the context menu.

8. Rename the database.

9. Double-click the spot color you estimated the target values for and select the correct gamut file for
your printer-medium combination (Profile Settings: Gamut).

10. Select the required Separation mode, depending on the printer driver and printer type. (Inkjet for
standard CMYK printers)

11. Redefine the paper tint if required (Edit menu > Define Paper Tint).

12. Calculate the CMYK output values in the Colors column (Measure menu > Calculate with Target
Values).
(Deactivate the option Subtract Paper Tint before recalculating.)

13. Optimize the profile in an iterative process.

14. Activate the option Subtract Paper Tint again.

15. Save the database.
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